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1 Introduction 

Introduction 

This chapter provides a brief  introduction about the Flint IDE, scope of  this 
document and sets the context for the further reading., 
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1.1 Purpose of the Document 

Embien offers various cutting edge solutions for the industry. Of them, Sparklet Embedded UI library 

is a light weight library created to run on top of resource critical embedded systems. Intended for a 

wide range of applications not limited to Industrial HMI’s, Medical devices, consumer electronics, 

auto infotainment panels. RAPIDSEA – RAPId Deployment Suite for Embedded Applications is a set 

of configurable library designed for faster design and development of applications across various 

platforms. 

Flint IDE is designed to aid development of both these solutions. It is based on one of the most 

popular IDEs- Eclipse and available as a plug-in. Using Flint, users can develop screens for Sparklet as 

well as Embedded applications for RAPIDSEA.  

This document provides a complete overview of development with Flint IDE for both Sparklet and 

RAPIDSEA, including procedure for installing it in PC, creating new projects, configuring them as well 

as updating the plug-in. 

1.2 Scope of the Document 

This document explains the procedure to install and use the Flint IDE. It also provides in detail 

various option available when creating a project, configuring the available widgets etc.  

Information about using Sparklet Library of RAPIDISE is not a part of this and it is covered in 

separate documented under relevant heads available in http:\\www.embien.com\downloads page. 

1.3 Conventions Used 

The below table gives a summary of conventions used throughout the document. 

int main () Source code, most likely in C language 

Project Name Function/Feature/Option available in IDE. 

Table 1  Conventions used 

  



Development Overview 9 

 

2 Setting Up 

Setting Up 

This Chapter introduces Flint IDE, explains the procedure to install Eclipse, 
Flint IDE as well as upgrading the same.. 

  

Chapter 
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2.1 Overview 

As explained earlier, Flint is a Graphical tool to develop projects for working with Sparklet 

embedded Graphical UI library and the RAPIDSEA platform. Flint is implemented as an eclipse plug-

in to take advantage of the most popular development IDE. Taking advantage of cross platform 

availability of Eclipse, Flint can run across platforms including Linux, Windows, Mac-OS etc. 

This section explains the procedure to setup up Flint for developing Sparklet/RAPIDSEA projects. 

2.2 Prerequisites 

Flint is a light weight plug-in running on top of the Eclipse platform. Hence the requirements are 

same as the Eclipse platform being worked with. 

To download the eclipse, visit the eclipse download page at https://eclipse.org/downloads/ 

Feel free to download the version suitable for your host PC.  

Note: Flint IDE is developed and tested extensively with Luna version - eclipse-java-luna-SR2-win32-

x86_64. But we anticipate no problems in working with other versions/variants. 

Eclipse needs other dependencies like JDK etc which should be installed. Make sure the Eclipse 

package is extracted and working fine before proceeding to the next step. For any issues, in this 

process refer to Eclipse documentation and community. 

 

2.3 Installing Flint 

This section describes in details the steps involved in installing the Flint Plug-in. To begin with, the 

Flint plug-in is available from the Embien website.  

  

https://eclipse.org/downloads/
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Start the Eclipse. This should show a screen like this.  

 

Figure 1 Eclipse Welcome Screen 

This view may be visible only when you start the Eclipse very first time. Otherwise it might be 

showing a different perspective. 

Now select the Install New Software Option from the Help menu. 

 

Figure 2 Installing New Software 
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Then a pop up is shown asking for the New Software Site address. 

 

Figure 3 New Software Entry 

Now, press the Add button, which will again shows a dialog asking for the plug-in site. In the first 

field (“Name”), give a unique name to identify this server for e.g. Flint. In the Location field, provide 

the address  

http://www.embien.com/eclipse-plugins 

  

http://www.embien.com/eclipse-plugins


Development Overview 13 

 
This step is shown in the below picture. 

 

Figure 4 Flint Plug-In address 

Up on clicking the OK button, it should list the available plug-in in the site. It may not show the plug-

in as it is not categorized.  

 

Figure 5 Grouped By Category 
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Now uncheck the Groups Item by category checkbox. This will show the availability of Flint Plug-in. 

 

Figure 6 Flint Plug-in - Ungrouped 

Now enable the check box against the Flint Plug-in and press the Next button. 

 

Figure 7 Installing Flint 
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After giving few Next and accepting the License agreement, the installer will show a warning about 

unsigned content.  

 

Figure 8 Unsigned content warning 

Continue with the installation by pressing OK button. Then Eclipse will ask for permission to restart 

itself. Press OK to restart immediately.  

Thus the Flint plug-in is successfully installed in our Eclipse setup. The procedure to create 

Flint/RAPIDSEA projects are explained in the next chapters. The next section explains the steps 

involved in updating the Flint plug-in. 

 

2.4 Updating Flint 

As Flint is constantly updated to incorporate new features, follow the below steps update your plug-

in to the latest version. 
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Start by clicking on the Install New Software item from the Help menu. 

 

Figure 9 Beginning Flint Update 

Click on the Available Software Site Link shown below the software site.  

 

Figure 10 Available Software Sites 
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A dialog will list the software sites from where the Eclipse and its components are installed. 

 

Figure 11 List of available software sites 

Now select the Flint plug-in and press the Reload button. This will reload the latest information from 

the Embien.com server. 

 

Figure 12 Reloading Plug-in information 
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Once updated, close the dialog and select the Flint plug-in site from the “Work With” drop down 

list. Give Next to begin installation. 

 

Figure 13 Update Process 

Few dialogs are shown as well as the License information. Up on accepting them, the Eclipse installs 

the latest plug-in and asks for restarting. Once restarted, the Eclipse is equipped with the latest plug 

in.  
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2.5 Flint Perspective 

There is a separate perspective available optimized for the Flint development. This can be chosen 

from the list accessible from Window ->Open Perspective->Other.  

 

Figure 14 Opening Perspective 

On the dialog, select Flint from the list shown. 

 

Figure 15 Selecting Fling Perspective 
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Once set, typically the following organization is shown. 

 

Figure 16 Flint Perspective 

As seen in this picture, the IDE is organized as views each for a particular purpose. The areas are 

explained as below. 

2.5.1 Project Navigator 

The left part of the view houses the Project Navigator. Here all the Flint projects created by the user 

will be visible. A project can be opened or closed. New projects can be created and unnecessary 

ones can be deleted. Other standard Flint project actions are also supported. 

2.5.2 Design View 

This is the central part of the UI where the Sparklet view can be designed. Users can design their 

screen in this view.  Flint offers various features that ease the UIO design. Some of them include 

Drag and Drop: 

New widgets can be dragged from the Widget tool box and placed here. All the properties of the 

created widget can be edited using the Widget Property area. 

Change Parent: 

It is possible to move a widget from one parent to another inside a view just by dragging the child 

and dropping it to the new parent. 
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Deleting Widgets: 

A widget can be removed from the view by double clicking it and pressing the Delete button. Flint 

asks for user confirmation before removing the widget. 

Source XML: 

All the resources in the Flint are managed as XML. When editing a EFV or EFW file, the XML markup 

of the same can be viewed from the Source tag of the design view. This view is only for read purpose 

and users can not edit this file from here. To edit the XML, external editors can be used. 

Note: Design view supports only one widget as direct child. To have more than one children, place a 

container widget like a Fixed view or list view and add multiple children to them, 

2.5.3 Widget Toolbox 

In the right side of the view, there is a tool box that displays all the supported widgets. From here, 

user can select the widget and place them in the design view. 

2.5.4 Outline 

Apart from the Widget Toolbox, there is another view in the right side called the Outline view. This 

will display the hierarchy of the view by listing all the children in a tree structure.  

2.5.5 Widget Properties 

Below the Widget Toolbox area, in the right bottom, there is a list available showing the properties 

of a currently selected widget. If the user double clicks on a Widget in the design view or Outline 

view, the properties of that widget is loaded to this view. User can edit each of these properties 

individually.  

2.5.6 Help Area 

In the status bar of the Eclipse IDE, the help corresponding to each widget property is displayed. 

When the user double clicks a widget, its properties are loaded in the Properties view. Then if any of 

the property is being clicked, then the help text corresponding to the property is loaded in the help 

area.  

2.5.7 Console 

Flint provides a separate console that is used to display the status of build operations. Any errors, 

issues, warning as well as success status are displayed in this view. 

2.5.8 Perspective Selector 

Eclipse perspective selector, usually available in the top, can be used to switch between 

perspectives. For example, user might go for a Java Perspective when editing a Java code and 

immediately switch back to Flint perspective when editing the screens. 



22 Development Overview 

 
With an understanding of the Flint perspective, we are now ready to proceed to develop Flint and 

RAPIDSEA projects. 
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3 Designing for Sparklet 

Designing for Sparklet 

This chapter provides with examples steps involved in developing Sparklet UI 
using the Flint IDE.  

  

Chapter 
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3.1 Introduction 

Flint IDE is primarily developed to aid developing screens for the Sparklet Embedded Graphics 

library. Various widgets available can easily be dragged and dropped from the tool box on to the 

design view and properties edited to suit user requirements. 

It is important to understand that the Flint is also capable of generating RAPIDSEA project as well as 

a project containing both RAPIDSEA and Sparklet features. So when a Flint Project is created it might 

have resources for both these. Also it is possible to have multiple Sparklet applications or windows 

in a same project.  

The below diagram explains the hierarchy for a Flint Project with relation to Sparklet and RAPIDSEA 

features. 

 

Figure 17 Flint Project – Sparklet/RAPIDSEA Relationship 

The bin directory contains files built, if no default path is set. The contents of the resource directory 

can be shared across all the Sparklet Apps and RAPIDSEA. The Sparklet Apps folder contains 

different Sparklet applications organized as directories. Each of these apps may have at least one 

Window and multiple views. 

We will now discuss in detail the steps involved in creating Flint project for a Sparklet application. 
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3.2 Creating Projects 

This section explains the procedure to create a new project for Sparklet using the Flint IDE. To begin 

with, right click on the Flint Navigator (in Flint Perspective) or Project Explorer (in other 

perspective).  On the pop-up menu, select the New option. Another sub-menu will be displayed. 

Select the Other option from it. 

 

Figure 18 New Project 

Up on selecting the Other option, a dialog will be shown listing different kind of projects supported 

be Eclipse. Under the Flint group, select Flint Project.  
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Figure 19 New Flint Project 

New Sparklet Application wizard will be started and will ask for the project name and its properties. 

Enter the project name. In this example, the Project name is My Demo. Also select the Project Type 

as Sparklet. In the bottom of the screen, enter the display resolution, 800x480 in this example. 

 

Figure 20 New Project Wizard 
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Now click on the brose button and select the path to the Sparklet library to which the output files 

from Flint will be copied to. 

Note: It must point to the sgui directory where there must be two sub-directories APP and FNT is 

present. Make sure this path is properly set. If not, the build process will fail.  

 

Figure 21 Output Path Selection 
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Once this path is selected, complete the wizard by giving Finish. 

 

Figure 22 Flint Project Wizard Completed 

Now the project is created. If viewed in Flint perspective, the below screen is shown. 

 

Figure 23 Project in Flint Perspective 

We will now proceed to create Sparklet applications.  
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3.3 Creating Applications 

To create a new Sparklet application that is going to be executed as a separate task, right click on 

the “sparklet apps” folder. On the pop-up select the New item followed by Other in the sub-menu. 

 

Figure 24 Creating New Sparklet Application 

In the dialog shown, select the Sparklet Application option and press Next. 

 

Figure 25 New Sparklet Application 
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The New Sparklet Application wizard is started. Enter the Folder name to hold the application. In 

this example, it is entered as MyApp. 

 

Figure 26 Application Name Entry 

 

Up on completing the wizard, the Sparklet application is created. A efw(Embien Flint Window) file is 

created and is ready for editing.  
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The below screen shows the MyApp.efw file opened in the design view. 

 

Figure 27 Window opened in Design View 

Now the widgets can be dragged and dropped on to the window. For example, click on the Fixed 

View in the widget tool box and place it on the design view. Double click on the dropped control and 

edit the properties.  

A brief help information for that property is displayed in the Help Area (status bar of Eclipse).  

For example, to change the view background color, click on the Background Color property and 

from the dialog select the color needed as shown below. 
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Figure 28 Editing Background Color of a Fixed View 

New view can be created apart from the window which can be placed programmatically on top of 

the window. To create a new view, right click on the Application directory (My App, in this case) and 

select New->Other. On the dialog, select Sparklet View option. 

 

Figure 29 Creating New View 
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Then the Wizard asks for View Name. Once entered, the view is created with a design view as below.  

 

Figure 30 New View after Creation 

 

3.4 Building Project 

Whenever Eclipse detects change in a resource, it will automatically build the project. In case a 

complete rebuild is required, enable the Build Automatically option in the Project menu and select 

Clean option.  
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Figure 31 Rebuild Project 

A dialog will be shown to choose the projects to be cleaned. Choose the necessary projects – either 

all or only specific ones. Once done, all the resources are built and source files generated in the 

configured output directories. 

 

Figure 32 Build Process completed 
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During build, the Flint displays various steps as well as the result of the operation. This information 

can be used to identify issues if any. 

3.5 Editing Project 

Whenever needed, the Flint project properties can be edited by opening the project properties 

section. To do the same, right click on the project and select Properties option in the pop-up menu. 

A dialog will be shown with a list of grouping in the left. Select the Flint option there and in the right, 

the Project Properties page will be loaded. Edit the fields as necessary and apply changes for them 

to take effect. 
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4 Designing for RAPIDSEA 

Designing for RAPIDSEA 

This chapter introduces concepts for the developer and sets stage for developing 
applications using RAPIDSEA with Flint IDE 
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4.1 Introduction 

RAPIDSEA support in Flint is not publically available for now. Expect update from us soon in this 

regard. A dialog will be shown with a list of grouping in the left. Select the Flint option there and in 

the right, the Project Properties page will be loaded. Edit the fields as necessary and apply changes 

for them to take effect. 

 

 



Appendix 39 

 

5 Appendix 

Appendix 

This section lists external information regarding Flint like Known issues, To Do 
lists etc 
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5.1 Known Issues 

Some of the known issues are 

 Flint has some issues known to occur when doing certain drag/drop operations.  

 During Drag operations, the rendering is not consistent as it is not double buffered. 

Our team is continuously working on improving the same. We expect all these issues to be closed 

soon.  

 


